
EDS374	  Secondary	  Mathematics	  Methods	  
Intro	  to	  Technology	  in	  the	  Math	  Classroom	  
	  
This	  guide	  gives	  an	  over	  view	  of	  some	  tools	  and	  websites	  that	  may	  be	  useful	  in	  the	  
mathematics	  classroom.	  	  
	  

 Poll	  Everywhere	  
 Virtual	  Manipulative	  Library	  
 Interactive	  Whiteboards	  
 Geometer’s	  Sketchpad	  
 Spreadsheets	  

	  
Poll	  Everywhere	  http://www.polleverywhere.com/	  
	  
On	  the	  surface,	  Poll	  Everywhere	  is	  a	  simple	  text	  message	  
voting	  application	  that	  works	  well	  for	  live	  audiences.	  
People	  vote	  by	  sending	  text	  messages	  (or	  using	  Twitter)	  to	  
options	  displayed	  on-‐screen.	  The	  poll	  that	  is	  embedded	  
within	  the	  presentation	  or	  web	  page	  will	  update	  in	  real	  
time.	  
	  
You can vote by following the instructions shown on the poll when it is 
displayed. The poll does not need to be displayed to actively receive votes, but it does need to be "started" by the 
presenter on the edit poll page. In the US, you send a text message to the number 22333 that contains a voting 
keyword, like 1234, or blue. 
You can also vote via your poll's web page on Poll Everywhere, via an embeddable voting widget, on a phone's web 
browser using pollev.com, or via Twitter. 
	  
Virtual	  Manipulative	  Library	  http://nlvm.usu.edu/en/nav/vlibrary.html	  
	  
The	  National	  Library	  of	  Virtual	  Manipulatives	  (NLVM)	  is	  an	  NSF	  
supported	  project	  that	  began	  in	  1999	  to	  develop	  a	  library	  of	  
uniquely	  interactive,	  web-‐based	  virtual	  manipulatives	  or	  
concept	  tutorials,	  mostly	  in	  the	  form	  of	  Java	  applets,	  for	  
mathematics	  instruction	  (K-‐12	  emphasis).	  The	  project	  includes	  
dissemination	  and	  extensive	  internal	  and	  external	  evaluation.	  
	  
Interactive	  Whiteboard	  (see	  course	  syllabus	  for	  links)	  

 Mimio	  
 Promethean	  
 Smart	  Technologies	  

	  
An	  interactive	  whiteboard	  (IWB),	  is	  a	  large	  interactive	  display	  that	  connects	  to	  a	  
computer	  and	  projector.	  A	  projector	  projects	  the	  computer's	  desktop	  onto	  the	  board's	  
surface	  where	  users	  control	  the	  computer	  using	  a	  pen,	  finger,	  stylus,	  or	  other	  device.	  The	  
board	  is	  typically	  mounted	  to	  a	  wall	  or	  floor	  stand.	  
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Use ® to Construct a Working Model of the 
Pythagorean Theorem 

 
(c) 2010-01-30 R. Meisel 

 
In this activity, you will learn how to use the basic tools and menus of ® to 
construct a dynamic working model the Pythagorean Theorem. 
 
What is ? 
 
   (GSP) is dynamic geometry software useful for exploring plane geometry, 
algebra, calculus, statistics, and other branches of mathematics. It is possible to simulate three-
dimensional geometry as well. Thousands of sketches are available on the Internet, most of them free. 
Version 4 is most commonly found in schools, although Version 5 was released late in 2009. Sketches are 
upwardly compatible. Version 5 also includes a provision for saving files in a format that will work on 
Version 4. 
 
The Workspace 
When you run GSP, the workspace looks like this: 
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The tools buttons are at the side, and dropdown menus are along the top. 
 
Draw a Right T riangle: 
    Straightedge Tool. 
     
 
Tip: You can draw a horizontal, vertical, or diagonal segment by holding down the Shift key. 
 
Next, fix an angle at 90°. 
    nt of the segment. 
     
    Construct menu, select Perpendicular L ine. 
 
A line perpendicular to the segment is drawn through the point. 
 
    Point Tool. 
     
    Select the perpendicular line. 
    Display menu, select Hide Perpendicular L ine.  
 
Tip: Alternatively, hold down the C T R L  key, and press h. 
 
    Straightedge Tool to draw segments that complete 
the triangle. 
 
Click and drag each of the vertices in turn. Notice that the triangle 
remains a right triangle at all times. 
 
Measure Lengths 
 
     
    Measure menu, select Length. 
 
Labels will appear for each of the vertices. Three length 
measurements will be displayed. 
 
Save the Sketch 
 
    F ile menu, select Save As... . 
 
Navigate to a suitable directory, and select a descriptive name 
for your sketch. 
 
    Save. 



Page 4 tchpad® Tutorial  

Calculate Squares 
 
    Measure menu, select Calculate... . 
 
The calculator box will appear. 
 
     
     
    O K . 
 
The square of the hypotenuse will appear.  
 
    Measure menu, select Calculate... . 
     
     
     
     
     
    O K . 
 
The sum of the squares of the other two sides will appear. 
 
Tip: You can use the Selection A rrow Tool to move a measurement to a convenient location in the 
workspace. 
 
Click and drag each of the vertices in turn. Note 
that the Pythagorean relationship holds at all 
times. 
 
Draw Squares on the Sides 
 
To complete the model, you will draw squares on 
the sides of the triangle. These will change 
dynamically as you drag the vertices. 
 
    -click on the vertex containing the 
right angle. This marks the point as the centre of 
rotation. 
    
end of the side. 
    T ransform menu, select Rotate... . 
 
A faint point will be plotted to show you the 
location of the rotated point and side. Note that 
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rotations are counter-clockwise.  
 
     
    Rotate. 
 
The rotated segment and point will appear. 
 
    -click on point C to mark it as the centre of rotation. 
     
    Straightedge Tool to complete the square. 
     
    Construct menu, select Quadrilateral Interior. 
 
The square will be filled in with colour. You 
can select the interior, and change the colour by 
selecting Color from the Display menu. 
 
Tip: Alternatively, you can right-click on the 
interior, and select Color. 
 
Use this procedure to draw squares on the other 
sides of the triangle. Select colours of your choice. 
 
Finally, construct a triangle interior for the right triangle, 
and colour it. 
 
Save your sketch. 
 
Add a Page 
 
You can add pages to your sketch. 
 
    F ile menu, select Document Options... . 
    Add Page. 
    Blank Page. 
    O K . 
 
Your new page will appear. You could also have chosen 
to duplicate the first page. 
 
You can toggle among the pages using the buttons at the lower left of the workspace. You can also use 
Document Options to change the names of the pages. 
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Another Way to Draw a Right T riangle 
 
    Compass Tool. 
     
 
Note that the circle is defined by a centre, and a point on the circle. 
 
    T ransform menu to rotate the point on the circle 180° about the centre. 
    Straightedge Tool to draw a diameter. 
    Point Tool to draw another point on the circle. 
    Straightedge Tool to complete a triangle in the semicircle. 
     
    Measure menu, select Angle. 
 
The measure of the angle in the semicircle will appear. Drag each of the 
vertices of the triangle in turn, and observe what happens.  
 
     
 
You can now complete a model of the Pythagorean Theorem using this 
triangle, if desired. 
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Box and Whiskers

The box-and-whiskers plot (sometimes just called a box plot) is a recent development 

in statistical analysis. You cannot derive any detailed information from it, but it 

gives you a convenient, easily understood graphical representation of the data 

distribution.

 SKETCH AND INVESTIGATE

 1. Open Box and Whiskers.gsp.

The sketch contains ten data values represented as points on parallel lines. 

Above the points are a box and whiskers. You can change a value by sliding its 

corresponding point right or left. The data are ordered and displayed on the left, 

but the actual numerical values are not important for this activity.

 2. Before answering any of the questions, take a minute to experiment with the 

sketch. Drag the data points and observe the effect.

Each of the following questions suggests a special shape for the box and whiskers. 

In each case, state whether it is possible. If it is not possible, explain why not. If it is 

possible, make a rough sketch of the data points that will create that confi guration, 

and suggest a real data set that might make this happen. The fi rst one is done as an 

example.

 Q1 Can one whisker have zero length?

 A1 This will occur if the lower one-fourth of the data points all have the same 

value. This might happen if there is a lower limit to the data range. Test a group 

of people to see how far they can throw a heavy weight. Those who cannot even 

lift the weight will all score zero.

 Q2 Can the median fall outside of the box?

 Q3 Can the box have zero width?
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Box and Whiskers
continued

 Q4 Can both whiskers have zero length?

 3. Press the Show Mean button. The mean is represented by a green bar. Normally, 

the mean is not shown on a box-and-whisker plot. It appears here so that you 

can observe its relationship to the data distribution.

 Q5 Can the mean fall outside of the box?

x

 Q6 Can the mean be greater than the maximum?

x

Questions Q7–Q9 involve moving data points. In doing so, you are actually moving 

from one data set to another. In real life this could happen when a restaurant 

manager changes the prices of certain menu items, or when a sports team makes a 

player trade.

 Q7 By moving one or more data points, can you move the mean without changing 

the box, the whiskers, or the median?

x

 

x

 Q8 Can you move a single data point without changing the mean?

 Q9 Can you move two data points without changing the mean?

 Q10 Can you change the median by moving a single data point? 
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Box and Whiskers Activity Notes

Objective: Students manipulate data points and observe 

the effect of their changes on a box-and-whiskers plot. In 

the process they gain an intuitive understanding of the 

box-and-whiskers representation of data distribution.

Student Audience: Algebra 1/Algebra 2/Precalculus/

Statistics

Prerequisites: Students should already have seen the 

box-and-whiskers plot, and should understand the 

meaning of the fi ve-number summary and the mean 

of a data sample.

Sketchpad Level: Easy. Students drag points on a prepared 

sketch; they do no constructions.

Activity Time: 40–50 minutes. The actual computer lab 

work can be performed in 30 minutes or less, but more 

time will be needed to answer the open-ended questions.

Setting: Paired/Individual Activity (use Box and 

Whiskers.gsp) or Whole-Class Presentation (use Box 

and Whiskers Present.gsp)

SKETCH AND INVESTIGATE

 Q1 See A1 in the student section.

 Q2 No, this is not possible. The middle half of the data 

must fall within the box, and the median must be 

somewhere in that middle half.

 Q3 Yes. It will happen if the middle half of the data have 

the same value somewhere in the middle of the range.

  Imagine a math test with only two questions, one very 

easy and one very diffi cult. Nearly all of the students 

would score 1, but a few outliers could score 0 or 2.

 Q4 Yes. It is similar to the distribution in Q1, except that 

there is both a lower limit and an upper limit.

  Show a photo of the cast of Gilligan’s Island to a large 

group of people. Ask them to identify the characters. 

Many people have no knowledge of the show, and 

would score zero. Of the people who have seen the 

show, most would have no diffi culty naming all seven.

 Q5 Yes. This can be caused by a fairly close grouping with 

some extreme outliers.

x

  This situation has been modeled in real life in baseball 

labor disputes. The mean income of professional 

baseball players is very high. However, most 

professional players play in the minor leagues and 

earn a modest income. Relatively few outliers in the 

majors earn exorbitant salaries, raising the mean but 

having little effect on the median or the quartiles.

 Q6 No, this is not possible. The mean must be within the 

range of the sample. You can prove this algebraically.
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 Q7 Yes. When ten data elements are ordered, the fi ve-

number summary is defi ned by only six of the values. 

The minimum is x
1
, the maximum is x

10
, the fi rst 

quartile is x
3
, the third quartile is x

7
, and the median 

is the mean of x
5
 and x

6
. Moving any of the remaining 

four values will change the mean with no effect on the 

box, provided they do not pass any of these above-

mentioned points.

 Q8 No. The mean formula includes every data point, so 

changing a single value always affects the mean.

 Q9 Yes. If you move two data points the same distance in 

opposite directions, the sum stays the same, and so 

does the mean.

 Q10 Yes. The median is the mean of x
5
 and x

6
, so it is only 

necessary to move or replace one of these two points.



Click on an interior 
to select it. Then, in 
the Measure menu, 

choose Area. 

To confirm that this 
shape is congruent, 

you can copy and 
paste it. Drag the 
pasted copy onto 
the shape on the 

legs to see that 
it fits perfectly. 

Visual Demonstration of the 
Pythagorean Theorem Name(s): 

In this activity, you’ll do a visual demonstration of the Pythagorean 
theorem based on Euclid’s proof. By shearing the squares on the sides of a 
right triangle, you’ll create congruent shapes without changing the areas 
of your original squares. 

Sketch and Investigate 

1. Open the sketch Shear Pythagoras.gsp.
You’ll see a right triangle with squares
on its sides.

2. Measure the areas of the squares. 

3. Drag point A onto the line that’s
perpendicular to the hypotenuse. A

b
a c 

C 

Note that as the square becomes a
parallelogram its area doesn’t change.

4. Drag point B onto the line. It should 
B

overlap point A so that the two
parallelograms form a single irregular shape.

5. Drag point C so that the large square deforms to fill in the triangle.
The area of this shape doesn’t change either. It should appear
congruent to the shape you made with the two smaller
parallelograms.

b 
a c 

A 

C 

B 

b 
a c 

B 

A 

C 

b 
a c 

B 

C 

A 

Step 3 Step 4 Step 5 

To confirm that this Q1 How do these congruent shapes demonstrate the Pythagoreanworks for any right
triangle, change theorem? (Hint: If the shapes are congruent, what do you know
the shape of the 

triangle and try the about their areas?) 
experiment again. 
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Visual Demonstration of the 
Pythagorean Theorem (page 155) 
Prerequisites: Students will appreciate this more 
if they already have some experience with the 
Pythagorean theorem. 

Sketchpad Proficiency: Beginner 

Activity Time: 10–15 minutes. This short demon-
stration works well even if you have only a single 
computer with an overhead viewing device. You 
might coordinate it with any of the other activities 
in this section. 

Required Sketch: Shear Pythagoras.gsp 

Sketch and Investigate 

Q1 In this sketch, the squares on the sides of a right 
triangle are sheared, without changing their 
areas, so that a shape on the legs is congruent to 
a shape on the hypotenuse. This shows that the 
sum of the areas of the original squares on the 
legs of a right triangle is equal to the area of the 
original square on the hypotenuse, thus demon-
strating the Pythagorean theorem. 

Exploring Geometry with The Geometer’s Sketchpad Activity Notes—Chapter 8: The Pythagorean Theorem • 261 
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Creating a Gradebook in Excel

Spreadsheets are a great tool for creating gradebooks. With a little bit of work,
you can create a customized gradebook that will provide weighted scores and averages.
The following instructions describe the steps for creating a spreadsheet gradebook.

Gradebook Layout

Let’s start by laying out gradebook (see Figure 1).

Figure 1 Gradebook Layout

First, we created a title, First Term Fall 2001, so that we could identify the gradebook.
Second, we added labels for the various columns. Columns A & B are for student names.

This sample gradebook is simple in that it only has homework assignments and tests. We
have created column groupings (i.e., Homework Assignments and Tests) and column
headings (i.e., Week 1, Week 2, etc) for our assessments. For this class we will average
all the scores and compute the final grade.

Gradebook Formulas

Our next step is to create a formula to calculate average. The following steps are for
Excel. Other spreadsheets use a similar procedure, but may use a different formula.

1. Start by clicking in the cell where you want the average to appear. We selected
cell I5 (see Figure 1) which is the average for our first student.

2. Select Function from the Insert menu. Excel will display the Paste Function
dialog (see Figure 2). Select Statistical from the left list and Average from the
right list. Then, click Ok. (Sometimes the Average function will appear when you
click on the Most Recently Used category.)
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Figure 2 Paste Function Dialog

3. When you see the Average dialog displayed (Figure 3), click the red arrow to the
right of Number 1.

Figure 3 Average Dialog
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4. The dialog box is hidden and you can select the cells to include in the average.
Use the cursor to select all the cells that will have scores or grades in row 5 (see
Figure 4). Notice how the range of cells is displayed in the text entry box and in
cell I5.

5. Once you have selected the cells, click the red icon to the right of the area listing
the cells in the formula. Then, click Ok when the Average dialog box appears.
Once you have entered data into the cells, the average will appear in the average
column.

6. We could repeat these steps for each student, but there is an easier way to
duplicate the formula for each student. Our gradebook will have five students, so
we selected cells I5 through I9 by dragging our cursor. Next, we selected Fill
from the Edit menu, then Down from the Fill menu (see Figure 5). When we
released the cursor, Excel created a formula in each cell. (Shortcut: after
computing the Average in cell I5, click on cell I5, place your cursor over the
square in the bottom right of the cell, and drag the square to cell I9. Excel will be
automatically create the Average formula in each cell.)

Figure 5 Filling in cells

7. Now, we can add our students and some data to the cells. Figure 6 shows our
completed gradebook.

Figure 4 Selecting Cells for a Formula

Click to Finish
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Figure 6 Completed Gradebook

8. We need to make another fix with our gradebook. Notice that the averages are
displayed with 5 decimal points. We could select any number, but for this
gradebook, we want whole numbers. To change the formatting of the numbers,
select the cells and then select Cells from the Format menu. When the Format
dialog is displayed select Numbers from the list and then select 0 as the number of
decimal positions to display (See Figure 7).

Figure 7 Format Cells Dialog

9. Now, our spreadsheet is nice and neat, but we need to convert the average scores
to a letter grade for the report card. Entering the grades for just five students the
task is not a big chore, however, a class of 30 students or 5 classes of 30 students
can take a lot of time to assign letter grades. We can add one more function to
lookup the grades.

10. We need to start by first creating a grading scale (see Figure 8). Create this table
in any blank area of your spreadsheet. You can also include A-, B+, etc. Just keep
everything in order from low to high.
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Figure 8 Table with Grading Scale

11. Select the cell for the first student’s letter grade (J5 in our example). We will
create a formula to lookup the student’s letter grade based on the Average. The
formula uses the format  =LOOKUP (Average Grade Cell, Range of the table, the
column for the letter grade). The student’s average grade is in cell I5. Our grade
lookup table is spread over two columns and we define it by listing the top left
cell and the bottom right cell (B14 and C18). We will look the grade up in the
second column of the table.
How does it work? Let’s use the first average of 82 as an example. Excel goes to
our table and compares 82 to the values in the first column. It searches until it
finds a value higher than 82. When it compares 82 to the table of value of 89, it
stops and uses the previous cell as 82 is between 79 and 89. Excel then looks into
the second column and selects the contents, which is B to put in our grade
column. If the student had an average of 95, then Excel would choose the letter
grade from the highest column.

12. Let’s create the LOOKUP formula. First click on cell J5. Next, type the following
into the text entry box

=LOOKUP (I5,$B$14:$C$18,2)
We put dollar signs around the cell referents so that Excel would use them to
define our lookup table. Our formula tells Excel to take the average score from
Cell I5, find it’s location in our table consisting of two columns spanning from
B14 to C18, and then use the letter grade in the second column.

13. Press return after you enter your formula and the grade should appear. You can
now use the Fill function to create a formula for each remaining student (see
Figure 9). (Shortcut: after creating the formula in cell J5, select cell J5, place your
cursor over the square in the cell’s bottom right corner, and drag to cell J9. The
LOOKUP formula is automatically created in each cell.)
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Figure 9 Letter Grades

All that remains is to add some formatting to our gradebook. The labels for the
homework assignments and the tests are similar and could lead to some confusion when
entering the grades. We can shade these sections different colors to make each distinct.
The following steps illustrate how to add color shading to your spreadsheet.

1. First we want to select the cells related to the Homework Assignments by
dragging our cursor. While the cells are selected, select Cells from the Format
menu (see Figure 7. Next, click on the Pattern tab and Excel will display the color
palette (See Figure 10).

Figure 10 Color Palette

2. Select the color you want and then click OK. You can select additional cells to
create distinct areas in your spreadsheet (See Figure 11).
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Figure 11 Finished Gradebook

Spreadsheets provide a number of possibilities for your gradebook. For example, you can
determine the average grade for individual assignments as well as the average grade for
the final grades. You can also create a formula to weight different scores. For example,
you might want the homework assignments to count for 45% of the grade and the tests to
count for 55% of the grade.

If you have any problems, refer to Excel’s extensive Help menu. Excel offers some
powerful tools to help you manage classroom logistics.



A Resource for Free-standing Mathematics Units Graphs of Functions in Excel

 The Nuffield Foundation 1
Photo-copiable

This activity will show you how to draw graphs of algebraic functions in Excel.

• Open a new Excel workbook and look for the Standard Toolbar.

• If it is not there, left click on View then Toolbars, then Chart to make it appear.

• If it is not there, left click on View
then Toolbars, then Standard
to make it appear.

• Now look for the Chart Toolbar.
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To draw the graph of 23 −= xy  in Excel

• First you need to draw up a table of values for x and y.
Left click on cell A1  and type x – the heading for column A.
Left click on cell B1 and type y – the heading for column B.

x values

• To obtain whole numbers from 0 to 10 in column A:
Left click on cell A2  and enter the value 0
Left click on cell A3  and enter the Excel formula =A2+1
Excel will put the value 1 in cell A3 as shown.

Now look for the little black ‘fill down’ square at the
bottom of the right-hand side of cell A3.

• Move the mouse until the cursor (cross) is on this square then left click  and at the same time
drag the mouse so that the cursor moves down column A.
Release the mouse button when you reach cell A12.

You should find that Excel enters values from 2 to 10 in cells A4 to A12.
Fill down copies the formula from A3 into the other cells, in each case increasing the cell
reference by 1, so that each value entered is one more than the last.

y values
• Now enter the Excel formula =3*A2-2  in cell B2.

Excel will work out the value of 203 −×  and put the result (i.e. – 2) in cell B2.

• Use fill down  to copy the formula into cells B3 to B12 .

The values and formulae
in the cells will now be as
shown here.

You can check the formulae
if you wish by left clicking
on each cell – the formula
will appear in the box
above the column headings.

‘fill down’ square

Cell A1

Values Formulae

This tells Excel to multiply the value
in cell A2 by 3 then subtract 2
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Now draw the graph as follows:

• Select the values in columns A and B by left
clicking on cell A1 and then dragging the mouse
until the cells are highlighted as shown.

• Now left click on the Chart Wizard:

The options for Step 1 of Chart Wizard will appear.

• Left click on
XY(Scatter)
and then the
last graph to
give a scatter
graph ‘with
data points
connected by
lines without
markers’.

• Then left click
Next.

This will take you
to Step 2.

This shows the
Data range i.e. the
references of the
cells that are
being used and
that the series is
arranged in
columns.

• Left click
Next to take
you to Step 3.
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• Enter the title and labels for
your graph as shown.

• Then left click on Gridlines
at the top.

• Left click on any of the
gridline boxes that are not
already ticked.  Ticks will
appear and gridlines will be
added to the graph as shown.

• Then left click on Legend.

A legend (or key) is useful when a
graph has more than one line, but in this
case it is not needed.

• Left click on the Show legend box
and the tick and the legend will
disappear.

• Then left click on Next.

In Step 4 you are given the choice of
having the graph drawn as an object
on the same sheet as the table or on a
new sheet by itself.

• Choose the second option as
shown, then left click Finish.
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Your graph will appear, but its appearance may leave a lot to be desired!

• Before starting to improve it, Save your spreadsheet, giving it an appropriate name.
Remember to save the spreadsheet periodically whilst you work on it.

Many other features of the graph can also be improved.
There is more than one way of obtaining the menus for doing this.

To alter the size and
shape of the graph, use
the handles.

• Use the corner
handles to enlarge
the graph.

• Use the side handles
to change its shape.

One way is simply to double left click
on the feature you wish to change.

• Left double click on the Chart
Area – this is the white part of the
graph.

This menu will appear.  It allows you to
change the appearance of the border and
background of the graph as well as the
font (i.e the text) and other properties.

• Experiment with these if you wish,
then left click OK.

If you don’t like the changes you have made, left click on the Undo button.
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Now try this third way of changing things:
Left click the arrow next to ‘Chart Area’ on the Chart toolbar.

This gives a list of things
you can change.

• Left click on Plot
Area and then on the
Format button.

The menu shown below
should appear.

Another way to obtain the Format menu for a feature is to right click
on the feature.  This method lets you format the feature and do other
things as well.

• Right click on the Chart Area of the chart.

This menu will appear. Selecting Format Chart Area would give the
menu for formatting the chart area again.  Selecting Chart Type,
Source Data, Chart Options or Location takes you back to one of the
Chart Wizard Steps you followed when setting up the graph.

• Experiment with these now if you wish.

Format button

• Left click on both None boxes and then
OK.

This will remove the grey colour from the
plot area on the graph.
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You can alter the scale and appearance of the axes and gridlines in a number of ways.

• On the Chart toolbar select Value (X)
Axis Minor Gridlines then left click the
Format button.

• In the Patterns menu set Colour to a mid-
shade of grey, rather than Automatic
(black).

This will make the minor gridlines less
obvious than the major gridlines.

(Another way of doing this is use different
Weights for the major and minor gridlines.)

• In the Scale menu enter the following values:

Minimum 0
Maximum 10
Major Unit 1
Minor Unit 0.2

When you enter values the ticks in the Auto
boxes will disappear.  This means Excel will
keep the scale you want and not change the
scale automatically if you change the size of
the graph.

• Left click OK.

• Now select Value (Y) Axis Minor
Gridlines on the Chart toolbar and left
click the Format button.

• In the patterns menu set the Colour to the
same shade of grey that you used earlier.

• In the Scale menu enter the values shown:

Minimum – 5
Maximum 30
Major Unit 5
Minor Unit 1

• Then left click OK.

N.B. If a value is
already there, just
click the Auto box
to remove the tick.

This will give a y-axis
from – 5 to 30 with
major gridlines at
intervals of 5 units and
minor gridlines at
intervals of 1 unit.
UsingIf a value is
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• Experiment with ways of changing the appearance of your graph.
• Draw graphs of other functions.  Some suggestions are given below.

Your graph should now look like this.

The y axis minor gridlines are selected
because they have just been changed.

Note that the label on the y axis looks odd.

To change the orientation:

• Left double click on the y axis title to
obtain the Format Axis Title menu.

• Then left click on Alignment.

• Use the mouse to move the red
marker at the end of the Text
alignment line until it lies in a
horizontal position.
(Alternatively you could type 0 in
the Degrees box.)

• Left click OK.

The y should now be the right way up.

• Use the mouse to move the labels to
the ends of the axes if you wish, as
shown here.

To make the letters in the titles and labels
italic:
• Highlight a letter, then left click the

Italic button on the Formatting Toolbar
(if this is in view)
or right click on the letter, then select
Format Chart Title and choose the
Bold Italic option from the menu.
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Use Excel to draw graphs of the following functions.

In the first three use a scatter graph ‘with data points connected by lines without markers’
– the last Scatter Graph option.

In the others  choose a scatter graph ‘with data points connected by smoothed lines without
markers’ – the 3rd Scatter Graph option.

Excel formulae for:Function x values Value in A2 A3 B2 Fill down to

xy 5= 0 to 10 0 =A2+1 =5*A2 A12 and B12
32

1 += xy 0 to 10 0 =A2+1 =A2/2+3 A12 and B12
xy 25 −= 0 to 5 0 =A2+1 =5-2*A2 A7 and B7

2xy = – 4 to 4 – 4 =A2+0.5 =A2^2 A18 and B18
23xy = – 4 to 4 – 4 =A2+0.5 =3*A2^2 A18 and B18

32 += xy – 4 to 4 – 4 =A2+0.5 =A2^2+3 A18 and B18

x
y 1
= 0.2 to 5 0.2 =A2+0.2 =1/A2 A26 and B26

x
y 2
= 0.2 to 10 0.2 =A2+0.2 =2/A2 A51 and B51

Experiment with other functions if you have time.
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Unit Intermediate Level, Using algebra, functions and graphs
Intermediate Level, Making connections in mathematics
Advanced Level, Working with algebraic and graphical techniques

Skills used in this activity:
• drawing graphs of functions in Excel

Preparation
Students need to have some basic knowledge of computer terminology and the use of computers
(eg how to use the mouse and menus in Excel).

Notes on Activity
This activity can be used at the start of the course to introduce graph plotting in Excel.
The functions listed on page 9 can be altered or extended as you wish.

Suggested follow-up activities are listed below:

Using algebra, functions and graphs – Spreadsheet Graphs (in Skills Activities)
Making connections in mathematics – Linear Graphs (in Skills Activities)
Working with algebraic and graphical techniques – Interactive Graphs (in Starters)

Teacher Notes



 Activity: Mystery Functions

Download:
Mystery_Functions.xls - with the answers available (right click to save, left click to
open)

 Mystery_Functions_Hidden.xls - with the answer columns hidden (right click to save,
left click to open)

 Overview: There are 20 different mystery formulas in this spreadsheet. For each one the student
enters several numbers for the "Input" and examines what comes out for the "Result", trying to
determine each function by looking for patterns.

 Instructions:

Open the spreadsheet to be seen by the entire class, or have individual students open it at their
own computers.
Explain to students that this spreadsheet has 20 different formulas that they need to discover.
To figure out each formula they are to try several different numbers in the "Input" box for each
problem. Then they are to examine what they get in the "Result" box each time. They should
look for patterns to determine what the formula is. The may wish to write down the info from
their trials.
When they think they have an answer, they can check it by clicking in the corresponding box
under "Formula". The function will be shown in the formula bar above the sheet.
The 20 functions get harder as they go, starting with one operation, then progressing to two
operations, the use of parentheses, and finally exponents.
This activity is great for investigating patterns, working with variables and algebraic
expressions, and order of operations.

 

Excel Activity http://www.northcanton.sparcc.org/~technology/excel/files/myst...
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